LAB :: PGP (Pretty Good Privacy)

GnuPG : GnuPG forms the heart of Gpg4win — the actual encryption software.
Kleopatra : The central certificate administration of Gpg4win, which ensures uniform user navigation for all
cryptographic operations.

Download Gpg4win (GNU Privacy Guard for Windows) from https://www.gpg4win.org/index.html

Install GhuPG & Related application

1. The installation assistant will start and you will see this welcome dialog:
@ Gpg4win Setup - X

GPG\\4WiN Welcome to the installation of
Gpg4win

Gpg4win is a installer package for Windows for EMail and file
encryption using the core component GnuPG for Windows.
Both relevant cryptography standards are supported,
OpenPGP and S/MIME. Gpg4win and the software induded
with Gpg4win are Free Software.

Click Next to continue.

This is Gpg4win version 2.2.5
file version 2.2.5.31818

release date 2015-07-10

2. Close all programs that are running on your computer and click on [ Next ]

3. The next page displays the licensing agreement — it is only important if you wish to modify or forward
Gpg4win. If you only want to use the software, you can do this right away — without reading the
license.



@ Gpg4win Setup - X

cense Agreement
@ Thls software is licensed under the terms of the GNU General
Public License (GPL).

Press Page Down to see the rest of the agreement.

Gpg4win consist of several independent developed packages, available under A
different license conditions. Most of these packages however are available

under the GNU General Public License (GNU GPL). Common to all is that they

are free to use without restrictions, may be modified and that modifications

may be distributed. If the source files (i.e. gpg4win-src-x.y.z.exe) are

distributed along with the binaries and the use of the GNU GPL has been

pointed out, distribution is in in all cases possible.

What follows are the terms of the GNU GPL; for a list of individual
copyright and license notices please see the installed README file.
v

In short: You are allowed to run this software for any purpose. You may distribute it as long
as you give the recipients the same rights you have received.

Clickon [ Next ]

. On the page that contains the selection of components you can decide which programs you want to
install. A default selection has already been made for you. You can also install individual components
at a later time. Moving your mouse cursor over a component will display a brief description. Another
useful feature is the display of required hard drive space for all selected components. Bellow are the
application and there fucntion:

a. GnuPG: Gnu Privacy Guard

b. Kleopatra: Keymanager for OpenPGP

c. GPA: GNU Privacy Assistant

d. GpgOL: GnuPG for Outlook

e. GpgEX: GnuPG Shell Extension

f. Claws-Mail: Claws Mail user client

g. Gpg4win Compedium: The Gpg4Win documentation



@ Gpg4win Setup - X

Choose Components
\ @ Choose which features of Gpg4win you want to install.

Check the components you want to install and uncheck the components you don't want to
install. Click Next to continue.

Select components to install: m Desaription
Position your mouse

Kleopatra over a component Eo
E] GPA see its description,
GpgOL

GpgEX

[[] clawsMail

Gpg4win Compendium

Space required: 99.2MB

Mullsoft Install System v2,46-7

Clickon [ Next ]

5. The system will suggest a folder for the installation, e.g.: C:\Programme Files (x86)\GNU\GnuPG You
can accept the suggestion or select a different folder for installing Gpg4win.
@ Gpgdwin Setup - X

Choose Install Location
\ @ Choose the folder in which to install Gpg4win.

Setup will install Gpg4win in the following folder. To install in a different folder, dick Browse
and select another folder. Click Next to continue.

Destination Folder

| :\Program Files (x86)\GNU\GnuPG Browse...

Space required: 99.2MB
Space available: 8.4GB

Mullsoft Install System v2,46-7

Thenclickon [ Next ]

6. Now you can decide which links should be installed — the system will automatically create a link with



the start menu. You can change this link later on using the Windows dashboard settings.
@ Gpgdwin Setup - X

Install Options
\ @ Start links

Please select where Gpg4win shall install links:

Start Menu
[Ipesktop

[] Quick Launch Bar

(Only programs will be linked into the quick launch bar.)

Mullsoft Install System v2.46-7

Thenclickon [ Next ]

7. If you have selected the default setting — link with start menu — you can define the name of this start
menu on the next page or simply accept the name.

@ Gpgdwin Setup - X

Choose Start Menu Folder
\ @ Choose a Start Menu folder for the Gpg4win shortcuts.

Select the Start Menu folder in which you would like to create the program's shortcuts. You
can also enter a name to create a new folder.

| T

Accessibility

Accessories

Administrative Tools
Gpg4win

Maintenance

Parallels Shared Applications
StartUp

System Tools

Tablet PC

Windows PowerShell

Mullsoft Install System v2,46-7

< Back Install Cancel

Thenclickon [ Install ]



8. During the installation process that follows, you will see a progress bar and information on which file is
currently being installed. You can press [ Show details ] atany time to show the installation

log.
@ Gpgdwin Setup —

Installing
\ \ @ Please wait while Gpg4win is being installed.

Extract: edit-find.png

Show details

< Back Next = Cancel

Q

Once you have completed the installation, please clickon [ Next ]

9. The last page of the installation process is shown once the installation has been successfully
completed. In some cases you may have to restart Windows. In this case, you will see the following

page:



@ Gpgdwin Setup -

GPG\\"WiN Completing the Gpg4win Setup
Wizard

Your computer must be restarted in order to complete the
installation of Gpg4win. Do you want to reboot now?

(® Reboot now

(O want to manually reboot later

< Back Cancel

10. Now you can decide whether Windows should be restarted immediately or manually at a later time.
Clickon [ Finish ]

And that’s it!
You have successfully installed Gpg4win and are ready to work with the program.

Create Certificate

1. Open Kleopatra using the Windows start menu:



fakrulalam

' Get Started

Get Skype

g Maps

a‘ People

E Calculator

Life at a glance

e

Microsoft Edge

Photos

Cut the cord

Q . i Cloudy
otepa Automatically

7 5 < %3 sync your stuff.

Washington,... 0=l OneNote
[/ ] Kleopatra

Play and explore

=l File Explorer

@ Settings

Algorithmic
Trading: the
Play-at-Home
Version

Power

= All apps

Search the web and Windows

2. You will see the main Kleopatra screen — the certificate administration:



™ Kleopatra - O X

File View Certificates Tools Settings Window Help

}_.1_@ Import Certificates | R Export Certificates e Redisplay [,y Stop Operation ‘ “ Lookup Certificates on Server lﬂ‘ | Clipboard

Ib‘ferfﬁ. .. SAIE+Q> |My Certificates LI

°| My Certificates l Trusted Certificates I Other Certificates I x|
Name © | E-Mail | ValidFrom | ValidUntl |  Details |  KeqD |

3. At the beginning, this overview will be empty, since you have not created or imported any certificates
yet.
Clickon File-»New Certificate .

4. In the following dialog you select the format for the certificate. You can choose from the following:
OpenPGP (PGP/MIME) or X.509 (S/MIME).

? X

™ Certificate Creation Wizard

Choose Certificate Format

Please choose which type of certificate you want to create.

@ Create a personal OpenPGP key pair
OpenPGP key pairs are created locally, and certified by your friends and
acquaintances. There is no central certification authority; instead, every
individual creates a personal Web of Trust by certifying other users' key
pairs with their own certificate.

@ Create a personal X.509 key pair and certification request
X.509 key pairs are created locally, but certified centrally by a certification
authority (CA). CAs can certify other CAs, creating a central, hierarchical
chain of trust.

Next Cancel

clickon [ Create personal OpenPGP key pair |

5. Now enter your e-mail address and your name in the following window. Name and e-mail address will
be made publicly visible later.

6. You also have the option of adding a comment for the key pair. Usually this field stays empty, but if you




are creating a key for test purposes, you should enter "test" so you do not forget it is a test key. This
comment becomes part of your login name, and will become public just like your name and e-mail
address.

? X

€« ™ Certificate Creation Wizard

Enter Details

Please enter your personal details below. If you want more control over the certificate
parameters, dick on the Advanced Settings button.

Name: IYour Name (required)
EMail: I Yourmail @Domain.com (required)
Comment: I PersonalComment (optional)

Your Name (PersonalComment) <Yourmail@Domain.com>

Advanced Settings...

Next Cancel

If you first wish to test your OpenPGP key pair, you can simply enter any name and fictional e-mail
address, e.g.:
Your Name and YourName@Domain.com

Clickon [ Next ]

. You will see a list of all of the main entries and settings for review purposes. If you are interested in the
(default) expert settings, you can view these via the All details option.



€ (™ Certificate Creation Wizard

Review Certificate Parameters

Please review the certificate parameters before proceeding to create the certificate.

Name: Your Name

Email Address:  Yourmail@Domain.com
Comment: PersonalComment
Key Type: RSA

Key Strength: 2,048 bits
Certificate Usage: Encrypt, Sign
Subkey Type: RSA

Subkey Strength: 2,048 bits
Subkey Usage: Encrypt

.......................................

Create Key Cancel

If everything is correct, click on [ Create key ]

8. Now to the most important part: entering your passphrase!
To create a key pair, you must enter your personal passphrase:

3 pinentry X

(‘-) ‘ Enter passphrase

Passphrase |oooooooo |
st

9. Choose passphrase which is easy-to-remember but hard to break secret passphrase.
To make sure that you did not make any typing errors, the system will prompt you to enter your
passphrase twice. Always confirm your entry with [ OK ]

10. Now your OpenPGP key pair is being created:



m Certificate Creation Wizard

Creating Key...
Your key is being created

The process of creating a key requires large amounts of random numbers. To
foster this process, you can use the entry field below to enter some gibberish
The text tself wonY be used at all, only the inter-character timing. You can also
move this window around with your mouse, or start some disk-intensive
application

This may take a couple of minutes. You can assist the creation of the required random numbers by
entering information in the lower input field. It does not matter what you type, as the characters will not
be used, only the time period between each key stroke. You can also continue working with another
application on your computer, which will also slightly increase the quality of the new key pair.

11. As soon as the key pair creation has been successful, you will see the following dialog:

? X

™ Certificate Creation Wizard

Key Pair Successfully Created

Your new key pair was created successfully. Please find details on the result and some
suggested next steps below.

—Result

Certificate created successfully.
Fingerprint: 0C2131EE0D849672853BC699CS0C 1BB96SBECTA7

—Next Steps

Make a Backup Of Your Key Pair... |

Send Certificate By EMail. .. |

Upload Certificate To Directory Service... |

Finish

The 40-digit “fingerprint” of your newly generated OpenPGP certificate is displayed in the results text
field. This fingerprint is unique anywhere in the world, i.e. no other person will have a certificate with



the same fingerprint. Actually, even at 8 digits it would already be quite unlikely that the same
sequence would occur twice anywhere in world. For this reason, it is often only the last 8 digits of a
fingerprint which are used or shown, and which are described as the key ID. This fingerprint identifies
the identity of the certificate as well as the fingerprint of a person.

12. However, you do not need to remember or write down the fingerprint. You can also display it later in
Kleopatra’s certificate details.

Next, Export certificate (public key):

1. Open Kleopatra or if it’s running you will see your key under My Certificates dashboad:

™ Kleopatra = O X

File View Certificates Tools Settings Window Help

gl Import Certificates [~ Export Certificates edisplay Stop Operation ookup Certificates on Server ™ Clipboard
I t Certificate E t Certificate: Redispl O Lookup Certificate: S ‘ .

| Search... <alt+Q> My Certificates |
_QI My Certificates I Trusted Certificates I Other Certificates I x_|

Valid From Valid Until
Your Name... Yourmail@do... 2015-08-10

Name Details

69BECT7A7

Right mouse click on your key and choose Export Certificate .

2. Choose your prefered location and name it with your key and save.




™ Export Certificates

X
<« v [ > fakrulalam > Desktop v O Search Desktop P
Organize v New folder B=c w (7]
# Quick access (s Name Date modified Type Size
I= Desktop * No items match your search.
& Downloads
Documents
[&=] Pictures b g
B Movies
D Music
7@ OneDrive
& This PC
. v £ >
File name: l MyKey| v|
Save as type: ’ OpenPGP Certificates (*.asc *.gpg *.pgp) v l
‘4 Hide Folders Save | I Cancel

3. You can open it in notepad and look like:



7] MyKey.asc - Notepad - O X
File Edit Format View Help

Version: GnuPG v2

mQENBFXINSEBCADRh2RXGzTUOBAEORWIyPtF8GGLjBCLbApqIdk7GjV1xDbDT6EVq
3Rs+AN112rJPNBHhZtKuTxRzdUWFYJIBIW2T1vyPQFm7WYXK7AsmyJvBs6clzZ2i
qDOznLw8UE6zQrIyrdhlLer06b/2pzMHsXxJENkKYACrYbp/+1yAWK1eBDZtZkDvfK
fdonJly3nyzOKGbfCvYpy8kklmyLY27g8CpmDIS580qZ118]PL50AaulzmnwiNl3kx
jMSSYq7sNPiU6LHOdBF2wh95nF7NWLiXBel trSPLSTuGhwgbkgBk+Q5XbJjbRbYn
1X01Z79guIDGf1lulgOTwEPgcpMy37684ff7IABEBAAGOMV1vAXIgTmFtZSAoUGVyY
€29uYWxDb21tZW50KSA8WWI1cmlhalixAZGItYWlulmNvbT6JATKEEWEIACMFALXI
NSECGWMHCwk IBwMCAQYVCAIICgsEFgIDAQIeAQIXgAAKCRDIDBuSab7Hp6NqCADR
G2NCVGZFcAS5kINLDWgZMX@CmBhanPhsML+hKxaxMbIwcH/JFxK7Ps/D9V+IBc+02
tjEo7dw9vA9mZORDCVak0009ryD8mX1MmdbdQDjQuMT3Epr6LfOhoS2aQHx2/308B
x8eZh/BvL13UdQzdRdxxDDGrsin6tHF6pMONopkB8Ur{9bxJLYZ00fd@cLmFtNSN
Ggwd+7TtMQhC88wiW6 TDF28UNuL4/I+8mEXe8Ukjdbn@qlcZVmxa95/VnywaHVpDt
ESD17uVC2IKFusM54eq/21Bn6sfLFEOp+mn1G+kRFAZIDmZOLc5ELQ1BO2vDRhd9
kKPr9zdVNOhtTEWSY532uQENBFXINSEBCACFIL30koD/+f25kBxsMegOOR3Nmv]a
1UYgirXD6eqvE+gKp8CGvpPMeM4gpSxjZZpqo/+xTItdzogbisdPnZd3wGRU1DZn
iTEvT6nF1BMCA16RuTO3IeQrxXIRouWc8olLid25xt3icfWE6gvdqfOyNdfaUHSc+
Iny+Htglp9vDjP1jCDzUL65H+QGNfcOLpEluvz+MAIpT1TvMU4KcBLcDBONXLXHV
MEYWhc1wEE1910bpUFB+N675i2T7M3edIVpvzYaxB/9EUkAiSs5Lwqvhu5SxI7YOU
i76+g0Kq2fkLuGyQORO30IjM8K8ZvHg /Atidfr6Pe@yCbPLFrHB+8uhHABEBAAG]
ARSEGAEIAAKFAIXINSECGwwACgkQyQwbulim+x6f8pQgAl4IRfoz3VB7hNCH/wx@I
OuyPkEa71Fxode9YuovnDIW4dkfnzsguAguXI4+QsR+PUIipApYWAxeupVuleE]zT
jT/cCiltAValCfMucHOYIMhXrDizqdWtRvQE6IU3pRStMOUPY3fhkYguBGqp2DSY
zt2AykgKUvOtByfI3auQHjImGYIQjCWLFM7h+jp03YX3KoVkqv8VG3A+ct+uRzbD
bQvisOFyHkn4pftEFgoKsX63hWHUELUWjt/SzCOYNntLEGo217]1ZVP /4zGucKfIk]
0i+D9Hy+41obefmB2A71sYN2KD1ttzZsACyD+bFHMa5TZTaabW3xNRvdqoS4nbnl
Xw==

=7F7m

This is your public key. You can share this key with outher via email or upload it to key server.

Encrypt Message

1. Create one new text file and type some message.

2. Select file; right mouse click and choose More GpgEX Options -> Encrypt



Open

Print
Edit
Sign and encrypt

Y More GpgEX options > Decrypt
Open with > Verify
Open on Mac Decrypt and verify
Show in Finder ZE
Share on > Sign
Restore previous versions Sign and encrypt

Import keys

sendio > Create checksums
Cut Verify checksums
Copy Help on GpgEX
Create shortcut About GpgEX
Delete
Rename
Properties

3. Next window will give you some extra option; we will procede with Next



™ Sign/Encrypt Files

What do you want to do?

Please select here whether you want to sign or encrypt files.
Selected file:

* //psf/Home /Desktop/TestMail. txt

I™ Archive files with: ~ |TAR (PGP@-compatible) ]|
Archive name (OpenPGP): I J/psf/Home [Desktop/TestMail. txt. tar a L
e mame (G ST - <
Archive name (S/MIME): I J/psf/Home [Desktop/TestMail. txt. tar.gz a L

(" Sign and Encrypt (OpenPGP only)
(¢ Encrypt
" Sign

™ Text output (ASCII armor)

™ Remove unencrypted original file when done

Next Cancel

4. Choose correspondence public key and choose Add and click Encrypt




€ ™ Sign/Encrypt Files

For whom do you want to encrypt?

Please select for whom you want the files to be encrypted. Do not forget to pick one of your own certificates.

ISee.rch, . IAII Certificates LI
Name Y E-Mail Valid From
- Your Name (PersonalComment) Yourmail@domain.com 2015-08-10

- APRICOT2015 (Test Key for APRICOT2015 NetSec Workshop) apricot2015@fakrul.com 2015-02-18 2

W Add A Remove |

Name E-Mail Valid From

{Your Name (PersonalComment) Yourmail@domain.com 2015-08-10
- APRICOT2015 (Test Key for APRICOT2015 NetSec Workshop) apricot2015@fakrul.com 2015-02-18 2

«| | LI

Encrypt Cancel |

5. After encryption you will get Encryption succeeded message. This will also create another new
file in same location with the extension of .gpg



™ Sign/Encrypt Files

Results
Status and progress of the crypto operations is shown here.

OpenPGP: All operations completed.

[V Keep open after operation completed

Finish Cancel

6. Attach this file as email attachment and send it to the receiver.

Decrypt Message
1. Save the encrypted file.

2. Right mouse click choose More GpgEX Options -> Decrypt



Open with

Decrypt and verify

§ More GpgEX options > Decrypt
Open on Mac Verify
Show in Finder Decrypt and verify
Share on > Encrypt
Restore previous versions Sign

Sign and encrypt

Send to > Import keys
Cut Create checksums
Copy Verify checksums
Create shortcut Help on GpgEX
Delete About GpgEX
Rename L=

Properties

3. Next window will give you some infomation regarding input file location and output file location.



™ Decrypt/Verify Files ? X

Choose operations to be performed
Here you can check and, if needed, override the operations Kleopatra detected for the input given.

Input file:  //psf/Home/Desktop/testencryption. txt.asc

[™ Input file is a detached signature

Signed data: | )

™ Input file is an archive; unpack with: |TAR (PGP ®-compatible) LI

[V Create all output files in a single folder
Output folder: [ //psf/Home/Desktop a _I;_.‘,J

Back Decrypt/Verify Cancel |

4. You will be asked for passphrase.

5.

If your private key passphrase match; it will decrypt the file and you will get following confirmation:



™ Decrypt/Verify Files

Results

All operations completed.

AN ARERNERNANERNERNENNANERNENNANNANERNER] oo%

testencryption. txt.asc — testencryption. txt: Not enough information to check signature validity. Show Details ’

[V Keep open after operation completed

Back ¥ OK

Cancel

6. Now you get the plain text; open it using any text editor.

Upload key to Key Server
1. Open your previously saved public key using notepad. Copy the full text.
2. Open any browser andgoto http://pgp.mit.edu/

3. Pastyourkeyin Submit a key andclick Submit this key to the keyserver!




B mIT PGP Key Server X |+

O
é ! O ‘ pop.mit.edu ';‘:7 | = @& ﬁ
MIT PGP Public Key Server

Help: Extracting keys / Submitting keys / Email interface / About this server / FAQ
Related Info: Information about PGP /

Extract a key

Search String: | || Do the search!

Index: ® Verbose Index: O
[] Show PGP fingerprints for keys

[] Only return exact matches

Submit a key

Enter ASCIl-armored PGP key here:

| Clear || Submit this key to the keyserverl

4. From http://pgp.mit.edu/ Yyou can search for you key or any other uploaded key.

5. Please note that you can’t delete/remove any uploaded public key from key server. You can only

revoke them.

Import Public Key from Key Server

1. Open any browser and goto http://pgp.mit.edu/

2. In search String field type email address for the correspondence public key and click

Do the search!

3. You will get the list of key/keys with KeyID. KeylID is the last 8 digit of fingerprint.



Click on KeylID.

Copy from --—-- BEGIN PGP PUBLIC KEY BLOCK----- till

B public Key server - Get X | 4 —

|||
N
& O

&~ = 0O ‘pgp.mitedu;’pks/lDokup?op:get&search:OxEdBA45E5DE26191CI ﬂ(‘

Public Key Server -- Get '"0xe4ba4S5e5de261910 "

Version: SKS 1.1.5
omment: Hostname: pgp.mit.ed

IMOENEFT ki PYBCACSYPU+tlgZlvnalge,/ 63 fE00aMbTOzi6shepHRnzrQLZ 83 6hAuT QK42 £
YaET1GJ0a0Pql swvdUdOT S 3DzWurd fhw/ XqMOYPHj s460HrX,/ ZBC5ZJ31v4 5g2ZEh INOMGD:
zPgTHSL0zcqCl1GT cd3xG65vIEN30v125b0M] 22 voX1M+OdyNWIwHDEUdh FAP P21 OHWVYAD
eb0gCm3pExSsyaAPmE N FrUdLg0WbQgw7O0tBMvwhE2inQg3Zkce 80rcbT+A1 SU2 JnTHDLE ZE
Yk02kg37Lip/ ckPOgERYguZS4R99P1171+3BH0CZ 2 Zg2I0DoKLVd] 96KDIgE/ yY3F0TARER|
AAGOTOFQUKIDT10vMDE1 IChUZENOIEC1eSBmb3Tg0VES SUNEVDIwWMT TgTmV 0T 2V IFdvemt =
aGOWESASYEXRyaWNvdDIwHMT VAZmFrenVeLmlvbhbT 6 JARWEEAECAAYFAI T sN4TAC gkQETT FyjA
FHUIgEf+03ulcFO0bYotNwWvZAHSO0pO0YOvg+S714+LuMi SwxbVoliT SuSclTMdmnIMOPXT awi 5
crMV0oCegETRE2ZWD1uT Fui sdZXFyRUInwaHwYWOWE j 5a+W4yTAWDmEThaSfjw/ 7151 rai vz
1Lt&HOzZ81hAd1 SrHPrsBcDDMPAXNEgrL3VEIZSLAZ 0 Jvo+ SNHW1 sn2YMBuBC6SJU6rjATL T
0vogl7evmTk]j opPCoARLSWEKWXGH4C3mbIg0De,/ 2HASM2X 8 3m6h400b,/ 0 FMET 4y iNd49JLi)
03GcjglnmjcauvlayrUN2ZMAQe 2WKIjDIWS71sred/CdXb5a6R1LhS SKav: EfS4kBEPOOTAQOA
TWICVOSISgIbAWDIBE4Y FgATLCOgHAWIVC gk ICWINAgGMEAR TeAQT X gAAKCRDku kX1 31 YZECT 7
B/8dg8iX8170a/V431MMppUie+B/GTZ0ZvT ZulblUwMkgOnESGTERAWE S PwTRkeTOM1 4dCk
vMeHX ] YERmjpvoNUNJE 34407 s £G1mmkwXNEDeKVLESCjdOSnWEZv S 8nFRYBCz JwemOy THEYZ T
vykieglJomOb/r3FI4+Cg0VEcgMICwOihiWGyDs1bZzawgtcxOFP1ITEZrtNI33IY0yi JEDMT ]
0+ 3 3vEWE3GeaCiDDW3IiY1zJjuvHE3eCFgSgV182r2gh=4,/ k2 culdkKYXjtOvEErnLE1dRIne|
RIMGEU+mF73BHchbY fTkZrgGJiz+SVDkreyBhvBn552ev0S JOEPUYGOZeuQENEFT ki FYBCACY
il/oVdcnHVgONetKU1J1BYGhSEhBwibvIOZE2XVdunlpGEZUAcQz+NvY3pC501 gpQSDY w1 DMA
IC8gAfoubS5as4o0Tgl8weDHTVO/ 83 TJ4pPIowT1lus5fiZK84LoCl Th3biovEi63PpUeiFEOrO1t
8 0h¥=2iWIz8h3xo6GLO6vegl/ 2FafZwSASIMibESvutWEl1kZ9qUDsA4eVIEIoUT cyQ3ENAL]
SATgm= pidSK1iMZesmix446R0/S5Y95TafihQ8t1Y+HADg] jEcw0SH/ FHIA1FUCV+/ jERe
AIN22VkEsTVznT72Xt 94+cGi/ LwpylEkz0SRouZ4a6vl4XFwi ISABEBAAGJASUEGAERAAS
A1TkiPYCGWWFCQeGH4AACTkQSLpF5d4mGREBppQgams / 3F80I+pe YNz Ex
GZFLTyKSyV3UoZCO/dUp8U0gMI00R 64 TVnwDEwwOSR+dNOCEOTKEGFVE

END PGF FUELIC KEY ELOCK

Now go to Kleopatra File->Import Certificate

™ Kleopatra — O *
File View Certificates Tools Settings Window Help
d New Certificate.. Ctrl+M ledisplay Q Stop Operation | &% Lookup Certificates on Server ﬁy Clipboard
& Lookup Certificates on Server... Ctrl+Shift+| My Certificates ;I
Crl+| brtificates | x ]
i Export Certificates... Cirl+E Valid Until Details Key-1D

6SBECTAT

1§ Export Secret Keys...
@ Export Certificates to Server... Ctrl+5hift+E

&2 Decrypt/Verify Files...
== Sign/Encrypt Files...

Create Checksum Files...
Verify Checksum Files...

€ Close Ctrl+W

B4 Quit Ctrl+Q




7. Browse the previoulsy saved public key and import it.

8. After successful inport it will show following message:
™ Certificate Import Result - Kleopatra ? X

Detailed results of importing Y\psfHome\Desktop'pubkey, bt
0 Total number processed: 1

Imported: 1

W OK

9. You will get those imported public key under Imported Certificate tab.

10. Double click on any key will open new window and show the key details which include Validity and
Fingerprint.

™ Kleopatra 4 Pt

Overview User-IDs & Certifications ] Technical Details ] Chain ] Cump ]

This certificate is currently valid.
User-TD: APRICOT2015 (Test Key for APRICOT2015 MetSec Workshop)
<apricot20 15@fakrul.com =
Validity: from 2015-02-18 18:13 through 2019-02-18 18:13
Certificate type: 2,043-hit RSA
Certificate usage: Signing EMails and Files, Encrypting EMails and Files, Certifying other Certificates
Key-ID: DE261910
Fingerprint: 3010395506430 7EEEF 17EDCEE4BA45SESDE261910
Ownertrust:  unknown
Stored: on this computer

Photo Actions

At the moment, Kleopatra does not support photos in Trust Certifications Made by This Certificate
certificates. It has no support for adding, nor for s LA catons ade oy s Lerare. -

displaying them. This is for the following reasons:

* Photos give a false sense of security.
* Photos increase the size of certificates.

€ Close E Help ‘

Sign other Public Key
1. Goto Imported Certificates tab of Kleopatra.

2. Right mouse click and choose Certify Certificate forthe key which you want to sign.



File Wiew Certificates Tools Settings Window Help

™ Kleopatra — O

>

I.S'ea.rc-‘:l,., TAfE+I > All Certificates
gl My Certificates | Trusted Certificates | Other Certificates Imported Certificates I

2

=1

Details

Marme i Valid From Walid Until
I APRICOT20... =

aprig] DE261910

Change Owner Trust..,
Trust Root Certificate
Distrust Root Certificate

| Certify Certificate...

Change Expiry Date...

Change Passphrase...

Add User-|D...
# Delete Del
[ Bxport Certificates... Ctrl+E

iy Export Secret Keys...
@a Export Certificates to Server... Ctrl+Shift+E

&¥ Certificate Details

3. Choose the Key you want to certifiy. Carefully check the fingerprint and click
I have verified the fingerprint .Click Next

™ Certify Certificate: APRICOT2015 (Test Key for APRICOT2015 MetSec Workshop)

Step 1: Flease select the user IDs you wish to certify,
APRICOT2015 (Test Key for APRICOT2015 NetSec Workshop) <apricot201 5@ fakrul.com:=

Certificate: APRICOT2015 (Test Key for APRICOT2015 MetSec Workshop) <apricot2015@fakrul. com= (DE261910)
Fingerprint: 8010395506430 7EEEF 17BDCEE4BA45ESDE201910

V¥ 1have verified the fingerprint

Mext Cancel

4. Choose the option Certify for everyone to see option. You can disable

Send certified certificate to server afterwards .Click Next .




€ ™ Certify Certificate: APRICOT2015 (Test Key for APRICOT2015 NetSec Workshop)

Step 2: Choose how to certify,

Certification will be performed using certificate Your Name (PersonalComment) <Yourmail @domain. com =,

(" Certify only for myself
(+ Certify for everyone to see

[ Send certified certificate to server afterwards

Certify

Cancel

5. You will be aksed for passphrase of your Pricate Key.

6. After successfuly sing; it will show confirmation message. Click Finish .

>
™ Certify Certificate: APRICOT2015 (Test Key for APRICOT2015 NetSec Workshop)
Summary:
Signed user IDs: APRICOT2015 (Test Key for APRICOT 2015 MetSec Workshop) <apricot2015@fakrul. com =

Selected secret key:  Your Mame (PersonalComment) <Yourmail @domain. com =

Certification
successul,

Finish

Cancel

7. Now you can export this publc key and upload it to key server.




Few Reference Link:
How to: Use PGP for Windows PC (GPG4Win; Mozilla Thunderbird; Enigmail)
https://ssd.eff.org/en/module/how-use-pgp-windows-pc

***END OF EXERCISE***



